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Proprietary Rights of Business Technology, Inc. (BTi) applications include the 

following: 

The Attendant Solutions suite of products and related data and information are 

proprietary and confidential to BTi and are the subject of trade secrets and 

copyrights licensed from BTi. The programs and related data and information are 

provided in confidence. All use, disclosure, copying, transfer, or storage of these 

items is strictly prohibited, except as authorized in the written License Agreement 

from BTi to the user. Information in this document is subject to change without 

notice and does not represent a commitment on the part of BTi. 

COPYRIGHTS: 

© 2023 Business Technology, Inc. (BTi).  All Rights Reserved. 

301 Mallory Station Rd., Suite 200, Franklin, TN 37067; United States of America. 

TRADEMARKS: 

BTi and the Attendant Solutions and individual application logos are registered 

trademarks in the United States of America. 

All other brand or product names mentioned may be trademarks of their respective 

companies or organizations. 
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Preface 

Welcome to the Early Warning Attendant™ 7.3 User Guide. This guide describes the 

features of the Early Warning Attendant™ application. 

Intended Audience 

This guide has been written for System Administrators, Meteorologists, and Master 

Control Operators to help in learning the functionality available in Early Warning 

Attendant. 

BTi Technical Support 

Technical support is available to answer questions and to help with any problems 

encountered using the Attendant Solutions suite of products. BTi Technical Support 

may be contacted in several ways: 

Method of Contact Information 

Website www.bti.tv 

Email support@bti.tv  

Voice U.S. 615 591 1900 x 1 

 

We Value Your Input 

We are interested in hearing your comments about this book, particularly if it fell 

short of your needs or expectations.  Please send your comments to support@bti.tv  

http://www.bti.tv/
mailto:support@bti.tv
mailto:support@bti.tv
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1      
Introduction 

Early Warning Attendant continuously monitors the station’s weather alert 

receiver for locally relevant alarms. It automatically extracts pertinent emergency 

weather information from the alert text and displays the warning on-air, online, and 

on mobile devices in a user-defined format via the station's existing graphics 

infrastructure. Early Warning Attendant interfaces with a wide variety of satellite 

and wire service receiving systems. 

Early Warning Attendant monitors, captures, and automatically broadcasts 

hazardous weather alerts in English, Spanish, and other languages. It provides 

designated users with alerts by email, transmission, or internal alarm (contact 

closure) based on Alert Severity Code, enabling those users to edit and approve 

alerts prior to airing. 

With Early Warning Attendant, station-defined maps, graphics, header, and footer 

promotional information are easily integrated into the transmission data stream. 

Branded or promotional header and trailer statements can be featured. Live 

Doppler video is also supported in a transmission, depending on CG capabilities. 

About This Book 

BTi developed this user guide to describe the features of the Early Warning 

Attendant . It consists of the following sections: 

Section Description 

2 – Accessing Early Warning 

Attendant 

Describes how to start Attendant 

Solutions and access the Early 

Warning Attendant 

3 – Configuring Early Warning 

Attendant 

Describes the EW Options screen that 

enables customization of the Early 

Warning Attendant for the particular 

station 

4 – Maintaining Regions Describes how to use the Maintain 

Regions screen to set up and maintain 

the regions, counties, and zones for 

which alerts are monitored  
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Section Description 

5 – Maintaining Weather Categories Describes how to use the Maintain 

Weather Categories screen to set up 

weather categories which best represent 

the weather events of interest to the 

station's viewers  

 

6 – Reviewing Alerts Describes how to create, view, and edit 

alerts for transmissions using the Review 

Alerts screen 

7 – Viewing Alert Status Describes how to view and send alerts 

that are ready for air using the View 

Status of Alerts to be Aired screen 

8 – Transmitting Weather Warnings Describes how to view active alerts, 

create new alerts, activate alerts, edit 

existing alerts, and delete alerts using 

the Transmission Status screen 

9 – Reports Describes how to use the Reports screen 

to view and print reports generated by 

Early Warning Attendant  

 



Early Warning Attendant User Guide 7.3 

Business Technology, Inc. Rev. May, 2023 3 

2 
Accessing Early Warning Attendant™ 

To start Attendant Solutions and access Early Warning Attendant, double click 

the Attendant Solutions icon found on the computer desktop to open the Login 

screen. 

Enter your User ID and password and then click [Login].  

Note: Contact your system administrator if you do not have an assigned User ID 

or password. 

The Main Menu screen displays. 

 

 

Note: The applications displayed on the right of the screen will vary depending 

upon which applications the station has purchased. 

Click the [Early Warning] button to open the application.  

The menu bar at the top changes to show Early Warning in the dropdown list and 

displays buttons associated with the Early Warning Attendant application. 
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3 
Configuring Early Warning Attendant™ 

This section describes the Early Warning Options screen which is used to customize 

how the Early Warning Attendant works.  

To access the Early Warning Options screen, select File > EW Options on the Main 

Menu screen. 
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The Early Warning Options screen displays with the 'Notify' tab open. 

 

 

'Notify' Tab 

The 'Notify' tab is used to edit and prioritize the notifications which are triggered on 

the system. Notifications may be customized to activate only when user-defined 

criteria are met.  

To prioritize notifications, click the notification to be prioritized and then click the 

[Up] or [Down] button to move the notification to the desired level. Notifications 

are executed in order, top to bottom. 

Note: The initial setup of all notifications for all applications is done using the 

'Notify' tab on the Configure Attendant screen, not on the EW Options screen. 

Select File > Configure Attendant to access the Configure Attendant screen. See 

the Attendant Solutions User Guide, page 23, for more details. 

To edit notifications, click [Edit]. 

The screen enters the edit mode. The parameters of any of the notifications can be 

edited while in this mode. 

A notification can fire when an alert is received or changed (AL), when an alert is 

ready to transmit (TX), or when a new alert is transmitted (UP). Click the appropriate 

cell to choose. 

Click the 'Severity' cell and use the dropdown arrow to choose the severity level of 

an alert needed to fire the notification.  
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Click the 'Interval' cell to enter the number of minutes to wait between alerts before 

a notification fires. 

Click [Save] to save any changes and exit the edit mode. 

'Controls' Tab 

The 'Controls' tab provides the ability to add, edit, and delete severity levels which 

are assigned to categories, and to use the Review Alerts section to set other 

parameters. 

 

 

 

Use the Severity group box to add new severity levels, and to edit and delete 

severity levels. Level 01 is the most severe and level 99 is the least severe. The 

severity levels, when defined, are assigned to individual event types to tell the Early 

Warning Attendant how to manage the alerts. For example, if both a Severity 10 

and a Severity 30 alert are assigned to the same county, the map reflects the most 

severe. Severity levels also define how notifications are used and the order in which 

text is transmitted.  

To create a new severity level, click [New].  

Enter the severity level number and a description.  

Click [Save]. 

To edit severity levels, select the severity level to edit and click [Edit].  

After making changes, click [Save]. 



Early Warning Attendant User Guide 7.3 

Business Technology, Inc. Rev. May, 2023 7 

To delete severity levels, select the severity level to be deleted and click [Delete].  

When asked to confirm, click [Yes]. 

 

Use the Review Alerts group box to configure how the Review Alerts screen 

(accessed from the Main Menu screen) displays information.  

• Clicking the “Default to Auto Refresh” check box enables automatic 

refreshing of the alerts grid.   

• The number entered in the "Refresh Interval" field (in seconds) determines 

how often the Early Warning Attendant looks for new alerts and refreshes 

the Review Alerts screen when the "Auto Refresh" box on that screen is 

checked. 

• Enter the number of days to show history information when choosing alerts 

received in the "Days to Show History Info for" box.  

• Clicking the “Show Auto Response Button” check box enables the Auto 

Response button on the Review Alerts screen, which can be used to toggle 

the automatic mode of the application.   

Click [Apply] when changes have been made.  

'Message' Tab 

The 'Message' tab is for customizing the on-air message. 

 
 

The "On Air Message" text box displays the customizable codes used to 

generate the on-air message.   



Early Warning Attendant User Guide 7.3 

Business Technology, Inc. Rev. May, 2023 8 

Caution: The message text may be altered but the variable codes between the 

percentage signs should never be altered! 

• %W% is replaced by the list of alerts  

• %C% is replaced by the list of counties 

• %T% is replaced by the end time of the alert  

• Other codes are shown in the "Message Variable Legend" table  

The "County Message when..." text boxes allow formatting additional messages for 

airing when a specified number of counties or more than a specified number of 

counties are included in an alert. A custom message may also be used when all 

monitored counties are included in an alert or when fewer counties are included. 

This allows for a shorter and more viewer friendly message instead of a long list of 

counties. 

The “Include State In On Air County List” check box gives the option of including 

the state with the list of counties to be aired. This is useful when the station's 

coverage extends over state lines. The state at the top of the list appears first in the 

list. To change the order of the states, click the [UP] and [DOWN] buttons. 

Use the Message Format group box to enter the text to be used to separate the 

counties (usually a comma or semicolon) and the time format to be used for the 

expiration time. 

Use the State Format group box to enter the text to be used to separate the states 

and the number of spaces to display before and after the separator. 

Be sure to click the [Save Message] button after the on-air appearance of the 

message has been customized. 
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'Images' Tab 

The 'Images' tab displays information about the Alert Map and Legend.  

Warning: Nothing should be changed on this screen without input from BTi. 

 

 

 

In the Map and Legend Output group box, "File Type" and "Image Path" reveal the 

image type and where the map is located on the server, respectively.  

The On Air Map group box shows the default colors, along with the height and 

width of the alerts map.  

• Border Color is the color of the border for the on-air map.  

• County Color determines the color of the counties when no alerts are 

present.   

• Default Color is the color to use if the alert is the same color as a border or 

county 

• Transparent Color specifies the color outside the map border which will 

appear transparent on-air. 

 

The Legends group box shows the height and width in pixels of the legends.   

 

The Alerts Screen Image group box shows "Magnification" of the image so counties 

can be clicked in the Review Alerts screen. Options include "Show Border" and 

"Show Expand Button". 
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'Mappings' Tab 

The 'Mappings' tab is used for setting options for mapping keyword times in the 

alerts from NWS stories.  

 

 

 

The Time Frames group box is used for setting times and descriptions for keyword 

mappings. Note that the times are not allowed to overlap. 

The Cancellations group box allows for specifying a time in minutes to keep 

cancellations. 

The Expirations group box contains the option to "Process Expirations". When this 

box is checked, the notice of expiration goes to air. 

The Show Start Time group box gives the option to show the start time in the alert 

message. 

 

'Database' Tab 

The 'Database' tab displays workstation information and current SQL data on the 

number of total alerts, date and time of last alert, and number of monitored 

counties that have been set up on the database. 
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‘NWS Msgs’ Tab 

The ‘NWS Msgs’ tab is used to edit the messages received by the National Weather 

Service by finding and replacing or deleting specified words or phrases. 

 

 

 

For example, the word “areal” could be replaced with the phrase “widespread area”. 
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4 
Maintaining Regions 

This section describes how to set up and maintain the regions, counties, and zones 

for which alerts are monitored. Regions are set up to best represent the areas of 

interest to the station's viewers. Each region consists of a list of counties and a 

region map. When an alert is received, it is assigned to all the regions which contain 

a zone or county included in that alert. 

To access the Maintain Regions screen, click [Regions] or select Edit > Maintain 

Regions on the Main Menu. 
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The Maintain Regions screen displays with the 'Regions' tab open. 

 

 

 

Adding Regions 

To add new regions, click [Add] at the bottom left of the screen. 

The New Region screen displays.  

Enter a unique name for the region in the "Region Name" field. 
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In the "Region Image" field, choose an image to assign to the region using the 

drop-down list. 

 

Choose counties from the available counties list and assign the counties to this 

region.  

Click [>>] to move all available counties to the region.  

Click [>] to move selected counties to the region.  

Click [<<] to remove all counties from the region.  

Click [<] to remove selected counties from the region. 

 

Note: Counties in red are already assigned to the current region. 

Click [Save] when done. 

Editing Regions 

To edit existing regions, select the region to be edited from the Regions list and 

then click the [Edit] button below the list. 
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The Editing Region screen displays. 

 

 

A region may be renamed, have a new map assigned to it, or include more 

counties.  

Note: Counties in red are already assigned to the current region. 

After making changes, click [Save]. 

Deleting Regions 

To delete a region, select the region to delete from the Regions list and then click 

the [Delete] button below the list. 

When asked to confirm, click [Yes]. 
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Assigning Counties to Region Maps 

Counties are associated with Region maps using the 'Regions' tab. This enables 

Early Warning Attendant to highlight the areas of the map that are affected by 

current alerts.  

To graphically assign the counties of a region to the map for the region, first 

choose the region from the list on the left, then click the [Set Map] button in the 

lower right-hand corner of the Maintain Regions screen.   

 

 

The Assign Counties screen displays. 
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Click the [Edit Assignments] button in the lower right-hand corner of the screen.  

The Assign Counties screen changes to Edit Assignments mode showing additional 

buttons on the bottom of the screen. 

 
 

Click the county to be assigned, and then click on the area of the map where the 

county is to be assigned. The map is color coded for ease of use. When a county is 

selected, it turns red until another county is selected from the column on the left. 

Once assigned, the assigned county turns yellow. An unassigned county displays as 

gray. 
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To assign the county to multiple areas of the map, click the [Same County] button, 

then click the areas to which the county should be assigned.  

To unassign counties, select the area to which the county is assigned and click the 

[Unassign County] button. 

When finished setting up all counties, click [Save].   

Note: Be sure the counties are assigned to the correct region of the map; 

otherwise, the on-air display of weather information will not be correct. 

 

Viewing / Editing Monitored States and Counties 

Use the 'Counties' tab to view:  

 - Monitored states and counties 

 - NWS code 

 - Member regions and zones to which a county belongs 

 

Monitored states and counties can be edited by clicking the ellipsis [...] button next 

to the lists of states and counties. 

To view or edit monitored counties, click the 'Counties' tab on the Maintain Regions 

screen. 

 

 

 

To edit the list of monitored states, click the ellipsis button next to the list of 

monitored states. 
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The screen will enter the Edit mode and a list of states will display, showing how 

many are being monitored. 

 

 

Clicking a state will set or remove a check mark in the left column.  

Check the states to be monitored.   
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Click the ellipsis button again to exit Monitored States Edit mode. 

 

To edit the list of monitored counties, click the ellipsis button next to the county list.  

 

 

The counties for the selected monitored state will display.  

The Available Counties list on the left contains a list of all counties for the current 

state.  

Note: Counties in red are already associated to the current state. 
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The Associated Counties list on the right contains a list of all the counties for the 

current state that are being monitored for alerts. 

Click [>>] to move ALL available counties to the Associated Counties list for 

monitoring.   

Click [>] to move the selected available counties to the Associated Counties list for 

monitoring.   

Click [<<] to move ALL associated counties to the Available Counties list to stop 

monitoring all counties.   

Click [<] to move selected associated counties to the Available Counties list to stop 

monitoring those counties.   

Click [Save] to save the list of counties being monitored. 

 

Viewing / Adding / Editing Monitored Zones 

Use the 'Zones' tab to view, add, edit, and delete monitored zones and see 

coverage information. 

Note: Zones and NWS Code numbers are set by the National Weather Service 

and do not change often. 

To work with monitored zones, click the 'Zones' tab. 

 

 

 

If the National Weather Service adds a new zone, then the new zone can be added 

by clicking the [New] button.   



Early Warning Attendant User Guide 7.3 

Business Technology, Inc. Rev. May, 2023 22 

 

The screen will enter the Add mode. 

 

 

Enter the NWS code number and name assigned by the National Weather Service, 

along with the list of counties contained in this zone.   

To associate counties to this zone, click [Associate Counties].  

The Associated Counties screen will display. 

 

 

 

The Available Counties list on the left contains a list of all counties for the current 

zone. Counties in red have already been associated. 
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The Associated Counties list on the right contains a list of all the counties for the 

current zone which are being monitored for alerts. 

Click [>] to move the selected available counties to the Associated Counties list for 

monitoring.   

Click [<] to move selected associated counties to the Available Counties list to no 

longer monitor those counties.   

Click [Close], then click [Save] to save the new zone. 

If the National Weather Service changes the coverage area for a zone or assigns a 

new Code to the zone, click the [Edit] button to update this information.   

 

 

 

Selecting a monitored zone on the left will show its associated information on the 

right. 
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Make the needed changes and click [Save]. 

 

To delete a zone, click the [Delete] button.  

When asked to confirm, click [Yes].   

Click [Exit] to close the screen. 



Early Warning Attendant User Guide 7.3 

Business Technology, Inc. Rev. May, 2023 25 

5 
Maintaining Weather Categories 

This section describes how to use the Maintain Weather Categories screen to set up 

weather categories which best represent the weather events of interest to the 

station's viewers. Each weather category consists of parameters that permit 

customization of the on-air display of weather events.  

To access the Maintain Weather Categories screen from the Main Menu, click 

[Categories] or select Edit > Setup Categories. 

 

 



Early Warning Attendant User Guide 7.3 

Business Technology, Inc. Rev. May, 2023 26 

The Maintain Weather Categories screen displays.  

 

 

 

The following table describes the Maintain Weather Categories screen elements: 

 

Phenomena and 

Significance 

List of National Weather Service alert types that are assigned 

to the category. The names of the alert types consist of a 

Phenomenon (e.g., "Flash Flood") and a Significance 

("Warning", "Watch", etc.). Click the column heading to 

rearrange the list order.  

Option to Monitor Check whether to monitor this alert or not. (Note the NWS 3-

letter code for the selected phenomenon is shown at the 

upper right of the screen.) 

 

On Air Text The text which is shown on air to identify the category 

 

On Air Text 2 Supplemental text which is shown on air to identify the 

category 
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Legend Text On-air text to be shown for the category legend.  For example, 

the on-air text may be "Severe Thunderstorm Warning" but 

because of space limitations, the legend text may need to be 

"Severe TStorm Warning." 

 

Map Color Color of a county on the region map when this weather 

category applies to that county. Each color has an associated 

number. 

 

Severity Severity of the weather category. Alerts are transmitted on air 

in the order of severity of their weather category. Alerts with a 

severity of 10 will appear before alerts with a severity of 20. 

Alerts with a severity of 0 are not monitored. 

 

Call to Action Instructions for possible individual action to be taken. 

 

Option to "Use 

NWS Message 

Text" 

When chosen, the exact message from the NWS will be 

inserted into the on-air crawl. 

Option for "Bullet 

Points Only" 

When chosen, only the bullet points from the NWS message 

will be displayed in the crawl, rather than the entire message. 

 

"Disable New 

Alerts" Option 

Choosing this option prevents the same alert from 

retriggering every time it is received. Any category that is a 

long-duration weather event, such as flooding, should be 

marked as "Disable New Alerts".   

 

 

 

Editing Categories 

To edit a category, start in the Maintain Weather Categories screen.  

 

To see all categories, uncheck the "Show Monitored Alerts Only" box at the bottom 

of the list.  

Double-click the category to be edited.  
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The screen changes to the edit mode, which allows changes to be made in the 

fields and checkboxes displayed on the right-hand side. 
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By default, the chosen category will be monitored. Uncheck this box if the category 

will not be monitored at this time.  

Make any necessary text changes within the boxes. 

To choose another map color, click the ellipsis [...] to the right of Map Color to 

display the Color screen.  

 

 

Select the preferred color or define a custom color by clicking on the [Define 

Custom Colors] button. 

After selecting a map color, click [OK]. 

 

The "Call to Action" box may be filled in on a per-alert basis and will follow the on-

air text. In order for the text in this box to be aired, %CTA% should be added to the 

On Air Message in EW Options > Message tab. Refer to Chapter 3, 'Message' tab. 

Click [Save] when editing has been completed. 
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6 
Reviewing Alerts 

Alerts for transmission may be created, viewed, and edited using the Review Alerts 

screen.  Previous alerts can be reviewed and re-aired.  

The Review Alerts screen is targeted at the station’s weather department. They edit 

the weather alerts and decide which alerts to send to air. This screen shows all of 

the alerts being captured from the National Weather Service, including long-

duration and disabled alerts, as well as alerts that need to be modified before being 

sent to air. When the alerts have been edited and configured for on-air display, 

then the Update process confirms these alerts for air. 

To access the Review Alerts screen, start from the Main Menu and click [Alerts] or 

select List > Review Alerts. 
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The Review Alerts screen displays. 

 

 

At the upper left of the screen, the options are to “Show Current Alerts” or “Show 

Alerts received”. If the latter option is chosen, specify the range of days to show the 

history of alerts. 

Note: To review alerts for a different region, click the [Regions] button on the 

main menu or select Edit > Maintain Regions. Under the Regions tab, move the 

region for which to view alerts to the top of the list using the [Up] and [Down] 

buttons.  

If an individual map is preferred for transmission, select the ”Show Individual Map” 

checkbox before clicking [Update]. The individual map only shows the map for the 

currently selected alert. 

If the consolidated map is preferred instead, uncheck the “Show Individual Map” 

checkbox before clicking [Update]. If a county is included in more than one alert, 

the color assigned to the county is for the most severe of those alerts. 

The following table describes the Review Alerts screen elements: 

 

Show Current  Alerts Displays current alerts 

Show Alerts received Displays all alerts received within a defined number 

of days 
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Region Displays all alerts for the specified region. The 

region specified is the region that is displayed on 

air when the [Update] button is clicked.  

Status column (Alerts grid) State of the alert. Options are:  

NEW – Alert has just been received and no action 

has been taken yet  

READY – Alert is ready to air  

AIRED – Alert has been aired by a transmission  

DISABLED – Alert has been marked as inactive  

Received column (Alerts grid) Date and time the alert was received 

Category column (Alerts grid) Category with which the alert is associated. (This is 

also shown in a dropdown box on the left.) 

Severity column (Alerts grid) Level of severity of the alert.  Lower numbers are 

more severe.  

Keep Alert Until Date and time the alert expires 

Aired At Date and time the alert was first aired 

Source Story from which the alert was extracted.  If the 

alert was manually entered, EWA appears as the 

source. 

History Displays a history of updates (both manual and 

data source)  to the currently selected alert 

Action Displays a list of alert actions to choose from 

Counties panel List of counties included in the alert 

Show Story Story from the National Weather Service that 

contains the alert information. Toggles between 

showing story, details, and map. 

On-Air Text Text that is sent to air for the alert. (“Create…” is 

not available unless editing.) 
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Adding Alerts to Regions 

To manually create a new alert for a region, start at the Review Alerts screen; the 

“Show Current Alerts” option should already be chosen. 

Click the [New] button.  

 

 

The screen will show a list of counties to the left of the associated region map and 

will populate the fields at the left of the screen.  

 

 

Choose a weather category from the dropdown box. 
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Select the affected counties by clicking the name of the county or clicking the 

county on the map. De-select a county by clicking again. 

 

 

Click the ellipsis button [...] to the right of the "Keep Alert Until" fields to set the 

alert expiration date and time and then click [OK].  

 

 

When alerts are created manually, they are automatically assigned to EWA as their 

source.  

Click the ellipsis to the right of the "Action" field to assign an action to the alert.  
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The Edit Action dialog box displays.  

 

 

 

Click the appropriate option and then click [Ok].  

Note: The “Create On-Air Text” and display picture will change to reflect the 

action chosen. 

 

Click the “Active” check box to send alert information to air. If the “Active” check 

box is not checked, the alert status changes to DISABLED and the alert does not 

appear on air. 

 

Click the [Create On-Air Text] button to create, view and edit on-air text. 
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Click [Save]. 

The alert displays in the Current Alerts grid at the top of the screen. 

 
 

Click [Update]. 
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The Confirm Alert Information screen shows exactly what is sent to the 

transmission. 

 

 

The map is displayed, along with the On Air Message. Only the alerts with check 

marks in the 'Show' column go on air. Messages can also be sorted using the [Up] 

and [Down] buttons. 

Click [Ok]. 

If the transmission is already running, this alert now goes on air. If the transmission 

is not running, it should be started manually whenever the alert is to go on air. 

 

 

Editing Alerts 

To edit an existing alert, select the alert to be edited and click [Edit]. 
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The screen will enter the Edit mode. 

 

 

Note the addition of the [Delete], [Cancel], and [Save] buttons on the lower left. 

Make any needed changes. 
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• Changing the weather category changes the on-air text and color of the 

counties. Click [Create On-Air Text] if the category of the alert has been 

changed. 

• Changing the region displays the associated map and list of counties for 

that region. 

• When the “Active” check box is unchecked, the Alert status is changed to 

DISABLED. This excludes alerts from both the map and the transmission 

text. 

• Change the time directly by entering a date and time or by clicking the 

ellipsis button and choosing the date and time from a calendar. 

Note that all counties are now shown. Clicking on a county without a check mark 

next to it adds the county to the current alert.  Clicking on a county with a check 

mark next to it removes the county from the current alert.  Counties can also be 

included or removed by clicking on their position on the map. County positions on 

the map are filled with the alert color when included. 

Click [Save]. The [Update] button turns red indicating the transmission needs 

updating. 

Note: If the updated alert information is to be sent to the transmission, click the 

[Update] button after saving the alert. 

Click [Delete] to remove an alert. The alert will no longer appear in current or 

historical alerts.   

Note: If there is a chance that the alert may be aired later, deactivate the alert 

instead of deleting it. To deactivate the alert, click the “Active” check box to 

remove the check mark and click [Save]. 

Creating On-Air Text for Transmission 

The on-air text for transmission can easily be created by clicking the [Create On-Air 

Text] button. If the automatically generated text does not meet requirements, click 

the [Show Story] button to view the entire original NWS story. Simply right click to 

copy and paste parts of the story into the On-Air text box or manually enter 

phrases from the original story to customize the transmission. The [Show Story] 

button toggles between the story, details, and the map. 

Click [Save]. A confirmation screen will display: 
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Click [Ok] if the changes are satisfactory. 

 

Alert Status Buttons 

The alert status buttons appear at the bottom of the Review Alerts screen. They 

include: "Auto Refresh", [Refresh], [Update], and [View]. 

Auto Refresh Option to automatically add an incoming 

alert to the alerts grid. 

Refresh  Adds an incoming alert to the alerts grid 

when clicked. The [Refresh] button turns 

red when a new alert is detected.   

Note: It is not necessary to use [Refresh] if 

the “Auto Refresh” check box is marked. 

Update  Sends the current alert information to 

the transmission.   

View  Displays the Current Transmission 

Information screen to view the alerts that 

are currently running on air or are set to 

run on air. 

 

 



Early Warning Attendant User Guide 7.3 

Business Technology, Inc. Rev. May, 2023 41 

7 
Viewing Alert Status 

The View Status of Alerts to be Aired screen is used to view and send alerts that are 

ready for air, as well as to manually start a transmission. The alert text can be 

included or excluded from the on-air transmission. 

Note: The View Status of Alerts screen only shows alerts that have been 

confirmed for on air display. This screen is targeted at operators who only need 

to see that there is an alert to send to air and are not responsible for editing or 

configuring the alerts. 

To access the View Status of Alerts to be Aired screen, start from the Main Menu 

and click [Status] or select List >View Status. 
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The View Status of Alerts to be Aired screen displays. 

 

 

 

The map shown in the upper left corner of the View Status of Alerts screen is the 

map that is currently being displayed on air. This map changes as new alerts are 

confirmed for air or old alerts expire. The legends next to the map are the legends 

being displayed on air. These legends are displayed in the same order as the 

corresponding alerts. 

The following table describes the View Status of Alerts screen elements: 

Job Name On air transmission job that can be aired from this screen 

Activate/Deactivate Used to change status of the selected job 

Select Only New 

Alerts 

Option that allows only those alerts with a status of READY 

to be quickly selected.  This allows only the text for the new 

alerts to be shown instead of all the currently active alerts. 

Status State of the alert 

On Air Message Text that will be sent to air for the alert 

Show Toggle to display or not display the alert text on air 



Early Warning Attendant User Guide 7.3 

Business Technology, Inc. Rev. May, 2023 43 

View Status of Alerts vs. Review Alerts Screens 

The Review Alerts screen is targeted at the weather department who edits the 

weather alerts and decides which alerts to send to air. This screen shows all of the 

alerts that are being captured from the NWS including long-duration and disabled, 

as well as alerts that need to be modified before being sent to air.  When the alerts 

have been edited and configured for on-air display, then the Update process 

confirms these alerts for air.   

The View Status of Alerts screen only shows alerts that have been confirmed for on-

air display. View Status is targeted at operators who only need to see that there is 

an alert to send to air and are not responsible for editing or configuring the alerts. 

Choosing Alert Text to Send to Air 

The exact text that is displayed on air appears in the center of the screen.  This text 

is the combined text from the alerts along with the beginning and ending 

messages. 

 

 

All the alerts that have been confirmed for air appear in the On-Air Message grid at 

the bottom of the screen.  A READY status means the alert has never been 

transmitted and is ready to be sent to air.  An AIRED status means that the alert has 

already been transmitted on air.   

• To remove the text of an alert from the On Air Message grid, uncheck the 

'Show' column.   

• To only show the text of the alerts that have not yet been aired, click the 

"Select Only New Alerts" checkbox.   
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• After making changes, click the [Refresh] button to send the updated alert 

information to the transmission. 

Starting Transmissions Manually 

The transmission that displays the on-air weather information can be started 

manually from the View Status of Alerts to be Aired screen if the user's profile 

permits.  

Note: If the user's profile does not permit starting a transmission, the 

Transmission group box will not appear on the screen.  

To start a transmission manually: 

In the Transmission group box, choose the appropriate transmission job to start 

from the "Job Name" dropdown box. 

Click [Activate] to start the transmission. If the job is already running, a message will 

appear indicating that the job is active. 

Click [Deactivate] to stop the job. 
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8 
Transmitting Weather Warnings 

The Transmission Status screen is used to: 

 Start, pause, and stop transmissions  

 View the status of transmissions  

 Create new transmissions based on existing transmissions 

 Edit and delete existing transmissions 

To access the Transmission Status screen, start from the Main Menu and click 

[Transmit] or select File>Transmit Alerts. 
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The Transmission Status screen displays. 

 

 

The display shows a list of transmission jobs in the main part of the screen, 

according to the selections made on the left-hand side. 

 

Note: In this application, the terms "job" and "transmission" are synonymous.  

 

Devices List 

The list of Devices at the top left of the screen shows devices for which jobs are 

available, as well as the status of the device and the port on which it is connected. 

Select a specific device to limit the job list display to that device only. (In this 

example, there is only one device, which is XPER-MENTAL.) 

 

Applications List 

The list of Applications on the left of the screen shows applications that have been 

installed on the server. Select a specific application to limit the display to that 

application. 

In the following example, the Early Warning application was chosen, which limits the 

job list to show only those jobs which pertain to the application. 
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At the right of the Applications list are two additional buttons: 

[Show Active Jobs 

Only] 

Limits the display to active jobs. 

[Show Hidden (*/#) 

Jobs] 

Shows jobs that have been marked as hidden. This 

option is only available to administrators. 

Groups List 

In the lower left section of the screen, custom Groups can be set up that contain a 

specific list of jobs for a particular user function. A group might be set up for each 

shift, for example. Groups may also be used to limit access to certain jobs. These 

groups can be managed with the [New], [Edit], and [Delete] buttons.  

 

Jobs List 

The main part of the screen consists of the Jobs list, which shows information about 

all the jobs which are currently available, their job ID, the devices associated with 

them, and their status. 

There are four columns which describe each job: 

 

Job ID A unique number generated by the application which 

represents a specific transmission or job that has been saved 

Job Name Name of the transmission job as created or edited by the 

user. The job name usually indicates or describes the type of 

transmission job. For example, “PM School Closings”. 
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Device The graphic device which will generate the output for the 

job. A job can only use one device.  

Status Indicates status of the transmission, either Active, Paused, or 

idle. A job's status will show as n/a (not available) if its 

associated device is not running. 

 

With the appropriate user permissions, these jobs can be edited and copied.  Jobs 

which have been previously duplicated from an original can also be deleted if the 

user has permissions, but original jobs cannot be deleted.  

Associated with each job in the list are buttons labeled as follows: 

  [Configure]  [Content]   [Start]    [Take] 

 

 

Configuring a Job 

When the [Configure] button is clicked for a particular job, its Configure Job screen 

will display: 

 

From this screen, job details can be changed or edited, conditions can be set for the 

automatic termination of the job, the job can be hidden, and the job can be copied 

or deleted. 

• A job must be assigned to a specific device (PC, server, or CG) on which the 

transmission is activated. Choose a device from the "Assigned to Device" drop 

down list. 
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• End Job group box - 

-- If needed, enter the time to stop this transmission or the number of cycles 

for this job to run. If these fields are left blank, the transmission runs continually 

until it is manually interrupted.  

-- When a job ends normally, it can link to another job. If this is to happen, 

choose a transmission job to be activated when this one ends.  

• Optionally, enter a priority value between 1 and 99, where 1 is the lowest 

priority and 99 is the highest priority. This value is used to prioritize jobs. The 

highest priority is often used for the most severe weather alerts. If the priority 

value is blank or set to zero, the job is not included in processing of priorities. 

When a priority is assigned, the number will show within brackets following the 

name in the jobs list.  

A note about priorities:  

When a job with a priority is started, it executes in the same manner as 

normal, but it also registers itself to the system. It is not until a second job 

with a priority starts that any changes are apparent. 

For example, if Job 1's priority is higher – Job 2 recognizes it should not be 

running and terminates itself. If both jobs have the same priority – Job 2 

terminates. If Job 2's priority is higher – Job 2 instructs Job 1 to terminate and 

then Job 2 continues.  When Job 2 is complete, it has the option to "Restart" 

the job it terminated, namely Job 1. This happens if the Job 2 "Restart" check 

box is set. 

Early Warning Attendant is capable of handling multiple job streams of 

priorities, as the case would be if the system is driving two character 

generators simultaneously.  Jobs with priorities for one CG, should not affect 

a job with a priority on another CG. By default, the name of the CG is used 

to control job streams, but other options are available if needed. 

• The job may be hidden from display all the time (name prefixed by *) or hidden 

only when active (prefixed by #). These options are often used for a job which 

should never be stopped. 

• Job details can be locked to prevent other users from making changes. 

• The job can be copied by using the [Copy Job] button. This would be useful if a 

job is needed to run on second device or at another time. To create a new job, 

an existing job with a similar function must be copied and modified to the 

user's requirements. See the section below for the procedure on creating a new 

job based upon an existing job. 

• To delete a job, click the [Delete Job] button. When asked to confirm, click 

[Yes].  

 

Editing A Job  

By using the [Configure] button, a job's attributes can be edited as described above, 

such as the job name, its assigned device, etc.  
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The [Content] button is used to further edit a job which was recently created or to 

edit the content of any other transmission job. Clicking the [Content] button for a 

job displays the Maintain Transmissions screen for that job: 

 

In this example, the Opening Message and Closing Message may be added or 

edited. 

Some transmissions have customizable fields that can be accessed by clicking the 

[Customize] button. When clicked, the Advanced Transmission Parameters screen 

displays, where more edits can be made. 

 

 

The Parameters in this screen will vary depending on the type of transmission. 

Modify the transmission parameters if necessary and click [Close]. 
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Starting / Stopping a Job 

On the Transmission Status screen, a job is started by clicking the [Start] button to 

the right of the job. 

 

When the job is started, the status shows as Active and the button icons change to 

show new functions - Stop and Pause. 

 

If the transmission is paused (by clicking the [Take] button), the transmission is 

taken off air, the Status changes and the [Take] button will change to allow 

resuming the transmission. 

 

 

When a job is started, the job's Status screen is displayed: 
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Note: This screen only appears on the device to which the job is assigned. Also, it 

may not be visible due to being hidden behind other open screens. 

The job Status window displays the following transmission information: 

Job Name Name of the job. It is displayed in red 

Started at: Transmission start date and time 

# Processed: Number of records processed for the current 

cycle 

End of Cycle: Time remaining until the end of a cycle 

Last Update: Time the transmission was last updated 

To pause an active transmission job, click the “Now” option to pause now, or click 

the “At End” option to pause the job at the end of the cycle, and then click [Pause]. 

Click [Resume] to restart the job at the point where it paused, or [Reset] to cause 

the job to start again at the beginning. 

To stop the transmission, click [Stop Now]. 

Clicking [Minimize] will minimize the Status window; the job will continue to run in 

the background. 

To close the Status window, click the [X] in the upper right-hand corner of the 

window. 

Creating A Job 

A new transmission job cannot be created from scratch; it can only be created by 

copying an existing job and modifying it to suit the needs of the user.  

To create a new transmission job based on an existing job: 

Select an existing transmission job that is the same type (manual, automatic, crawl, 

web page, etc.) as what the new job should be. 

Click the [Configure] button for that job. 

Click [Copy Job]. When asked to confirm, click [Yes]. 

The Configure Job screen displays for the new job. 
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A new job name and ID number is automatically generated.  

Enter a new job name, if desired. 

To complete the job creation process, see the above section on configuring a job.  

Click [Save] when done and close the screen. The new job will display in the 

Transmission Status screen. 
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9 
Reports 

Reports generated by Early Warning Attendant can be viewed and printed using 

the Reports screen.  

To access the Reports screen, start from the Main Menu and click [Reports] or select 

List > Reports. 
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The Reports screen displays. 

 

 

 

A report may be viewed, sent to a printer for a hard copy, or saved (exported) to a 

file. 

Select Early Warning from the Applications list on the left. 

Types of Reports 

The following table describes reports that are generated by Early Warning 

Attendant. 

Report Description 

Alerts History Report Listing of alerts since a specified date. The 

history is sorted by alert time / source / severity 

and also contains information about alert 

description / text / counties, stop alert date and 

time, and air alert date and time. 

Aired Alerts Report Listing of alerts that aired over a specified 

period. The report is sorted by air time and 

includes text of the crawl. 

EW Upgrade Report Listing of alerts which have been converted from 

the old alert code to the new code, along with 

the on-air text, severity, and color codes of the 

alerts.  
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Viewing Reports 

To view a report, select the report to view and click [Execute]. 

The report opens in the Report Viewer window. 

 

 

Printing Reports 

To print the selected report, click the printer icon at the top left of the Report 

Viewer screen. 

 

 

The standard Windows print dialogue box will open from which a printer may be 

chosen, as well as other options such as page range and orientation.  
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Saving Reports to a File 

To save the selected report to a file, click the Export icon at the upper left of the 

Report Viewer screen. 

 

 

 

An Export dialog box opens and provides a number of export formats in a drop-

down list. Select the format to be exported.  

Select a destination from the drop-down list and click [OK]. 

Select a Page Range or all of the report and click [OK]. 

Enter a file name and click [Save]. 

 

 


